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Matrizes e Vetores

• O Minitab trabalha com os seguintes objetos:
√ Números: armazenados nas constantes (K + nº)

Numeração até 1.000 constantes
√ Vetores: armazenados nas colunas (C + nº)

Numeração até 4.000 colunas
√ Matrizes: blocos de células (M + nº)

Numeração até 100 matrizes

Construção de Matrizes

• Construir a matriz:

• Digitação pelo teclado:
√ Editor > Enable Commands
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MTB > Read 4 4 M1 
DATA> 16 4 -8 4 
DATA> 4 10 8 -4 
DATA> 8 8 12 -10 
DATA> 4 4 10 -12 
4 rows read. 

 

Matrizes a partir de Colunas

• Carregue no Minitab a planilha: A (arquivo 
matrizes.xls).

• Crie a matriz M2:
Data > Copy > Columns to matrixè
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Carregando Matrizes de Arquivos

• Faça o download do arquivo be.txt

Calc > Matrices > Readè

Selecione o caminho até o arquivo

Visualização das Matrizes
 
MTB > print m1 - m3 
  
Data Display  
 
 Matrix M1 
 
16   4  -8    4 
 4  10   8   -4 
 8   8  12  -10 
 4   4  10  -12 
 
 
 Matrix Copy 
 
2  1  7   4  -3  -1   4   4   7   0 
4  2  2   3  -2   0   3   3   4   1 
3  4  4   2   1  -2   2   1   9  -3 
9  3  5   1   0   5   6  -5  -3   4 
2  0  7   0  -5   7   1   0   1   6 
1  9  8   0   3   9   9   0   0   5 
4  1  9   0   4   3   7  -4   1   3 
6  3  1   1   6   8   3   3   0   2 
6  5  0  -7   7  -7   6   2  -6   1 
1  6  3   4   8   3  -5   0  -6   0 
 
 
 Matrix M3 
 
86  45  52,5  108  66,5  90,5  139  61  -43,5  31 

 

Transposição de Matrizes

• Através de:
√ Editor > Enable Commands

 
MTB > Transpose M1 M7 
MTB > Print M7 
 
Data Display  
 
 Matrix transposta 
 
16   4    8    4 
 4  10    8    4 
-8   8   12   10 
 4  -4  -10  -12 
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Matriz Constante

• Através de:

Calc > Matrices > Define Constant è

MTB > print m8 
  
Data Display  
 
 Matrix M8 
 
2  2  2  2 
2  2  2  2 
2  2  2  2 

 

Matriz Diagonal

• Construção de matriz a partir de sua diagonal:
√ Numerar uma coluna de 1 a 20:
√ Editor > Enable Commands

 
MTB > Diagonal c11 M9 
MTB > print M9 
  
Data Display  
 
 Matrix M9 
 
1  0  0  0  0  0  0  0  0   0   0   0   0   0   0   0   0   0   0   0 
0  2  0  0  0  0  0  0  0   0   0   0   0   0   0   0   0   0   0   0 
0  0  3  0  0  0  0  0  0   0   0   0   0   0   0   0   0   0   0   0 
0  0  0  4  0  0  0  0  0   0   0   0   0   0   0   0   0   0   0   0 
0  0  0  0  5  0  0  0  0   0   0   0   0   0   0   0   0   0   0   0 
0  0  0  0  0  6  0  0  0   0   0   0   0   0   0   0   0   0   0   0 
0  0  0  0  0  0  7  0  0   0   0   0   0   0   0   0   0   0   0   0 
0  0  0  0  0  0  0  8  0   0   0   0   0   0   0   0   0   0   0   0 
0  0  0  0  0  0  0  0  9   0   0   0   0   0   0   0   0   0   0   0 
0  0  0  0  0  0  0  0  0  10   0   0   0   0   0   0   0   0   0   0 
0  0  0  0  0  0  0  0  0   0  11   0   0   0   0   0   0   0   0   0 
0  0  0  0  0  0  0  0  0   0   0  12   0   0   0   0   0   0   0   0 
0  0  0  0  0  0  0  0  0   0   0   0  13   0   0   0   0   0   0   0 
0  0  0  0  0  0  0  0  0   0   0   0   0  14   0   0   0   0   0   0 
0  0  0  0  0  0  0  0  0   0   0   0   0   0  15   0   0   0   0   0 
0  0  0  0  0  0  0  0  0   0   0   0   0   0   0  16   0   0   0   0 
0  0  0  0  0  0  0  0  0   0   0   0   0   0   0   0  17   0   0   0 
0  0  0  0  0  0  0  0  0   0   0   0   0   0   0   0   0  18   0   0 
0  0  0  0  0  0  0  0  0   0   0   0   0   0   0   0   0   0  19   0 
0  0  0  0  0  0  0  0  0   0   0   0   0   0   0   0   0   0   0  20 

 

Diagonal

• Obter diagonal de matriz
√ Editor > Enable Command

MTB > Diagonal M2 C12 
MTB > print c12 
  
Data Display  
 
C12 
    2    2    4    1   -5    9    7    3   -6    0 
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Operações com Matrizes

Soma de Matrizes
• É possível apenas para matrizes de mesma 

dimensão:
Ex. Somar M1 com sua transposta (M1t)

 
MTB > Add M1 transposta M9 
MTB > Name M9 Soma 
MTB > Print Soma 
  
Data Display  
 
 Matrix soma 
 
32   8   0    8 
 8  20  16    0 
 0  16  24    0 
 8   0   0  -24 

Comando válido também para colunas e constantes

Subtração de Matrizes
• É possível apenas para matrizes de mesma 

dimensão:
Ex. Subtrair M1 de sua transposta (M1t)

Comando válido também para colunas e constantes

MTB > Subtract M1 transposta M10 
MTB > Name M10 Delta 
 
MTB > print Delta 
  
Data Display  
 
 Matrix Delta 
 
  0   0   16   0 
  0   0    0   8 
-16   0    0  20 
  0  -8  -20   0 
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Multiplicação de Matrizes

• Operação permitida apenas se o número de 
colunas da matriz da esquerda é igual ao 
número de linhas da matriz da direita.

• Obter o produto de A.B
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MTB > Read 2 3 M10 
DATA> 1 2 4; 
DATA> 2 6 0 
2 rows read. 
 
MTB > Read 3 4 M11 
DATA> 4 1 4 3 
DATA> 0 -1 3 1 
DATA> 2 7 5 2 
3 rows read. 
 
MTB > Multiply M10 M11 M12 
MTB > Print M12 
  
Data Display  
 
 Matrix M12 
 
12  27  30  13 
 8  -4  26  12 

 

Inversão de Matrizes

• Operação possível apenas para matrizes 
quadradas

• Nem todas as matrizes quadradas possuem 
inversa.

• Inversão da matriz M1
 
MTB > Invert M1 M5. 
MTB > Name M5 'inversa' 
MTB > Print inversa 
  
Data Display  
 
 Matrix inversa 
 
 0,0271739  -0,112319   0,177536  -0,101449 
 0,0326087   0,231884  -0,253623   0,144928 
-0,0760870  -0,152174   0,369565  -0,282609 
-0,0434783  -0,086957   0,282609  -0,304348 

 

• O produto da matriz por sua inversa (ou 
vice-versa) é a matriz identidade.

MTB > Multiply M1 inversa m20 
MTB > print m20 
  
Data Display  
 
 Matrix M20 
 
1  -0  -0  0 
0   1   0  0 
0  -0   1  0 
0   0   0  1 
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Álgebra Matricial

Sistemas Lineares

• Matrizes são ferramentas importantes na 
solução de sistemas lineares.

• Ex.: Resolva o sistema abaixo:
16X1 + 4X2 – 8X3 + 4X4 = 32
4X1 + 10X2 + 8X3 – 4X4 = 26
8X1 + 8X2 + 12X3 – 10X4 = 38
4X1 + 4X2 + 10X3 – 12X4 = 30

• O sistema pode ser escrito como:

• E sua solução é obtida por:
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• O resultado será um vetor de tamanho 4:
(X1, X2, X3, X4)

• Podemos usar colunas. Digite em uma coluna 
o vetor (32, 26, 38, 30)

• E faça a operação (M1)-1 x coluna = solução

MTB > Multiply inversa c14 c15 
MTB > Print c15 
  
Data Display  
 
C15 
    1,65217    1,78261   -0,82609   -2,04348 

 

Exercício 1 – Solução de Sistema Linear

Resolva a seguinte equação matricial:
Ax = B, onde:
x= (x1, x2, x3, x4, x5, x6, x7, x8, x9, x10)
A: planilha A do arquivo matrizes.xls
B: arquivo be.txt

ftp://ftp.est.ufmg.br/pub/lupercio/be.txt

Solução

 
MTB > Inverse m2 m6 
MTB > Transpose m3 c16 
MTB > Multiply m6 c16 c17 
MTB > Print c17 
  
Data Display  
 
C17 
    3,0   -4,5    7,0    8,0    3,5    2,0    4,0   -3,5    2,0    1,5 
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Regressão Múltipla

• Predizer valores de uma variável 
dependente (Y)     em função de variáveis 
independentes (X1, X2, ..., Xk).

• Conhecer o quanto as variações de Xj (j = 
1,...,k) podem afetar Y.

Exemplo– Rede de Lanchonetes

• Modelo para explicar receita total em cadeia de 
lanchonete

• Semanalmente decide-se:
√ quanto gastar com propaganda e 
√ quais promoções (preços mais baixos) serão 

implementadas

• Dados: planilha lanchonete
• Fonte: Hill

Exemplo 5 – Rede de Lanchonetes

• Despesas de propaganda:
√ Aumento despesas gera aumento na receita?
√ Aumento de receita é suficiente para justificar 

despesas?
√ Redução de preços leva a aumento ou diminuição 

de receita total?
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Exemplo 5 – Rede de Lanchonetes

• Promoções:
√ Redução de preços leva a aumento ou diminuição 

de receita total?
√ Situações a ser verificadas:

Redução 
de preços è

Pequeno 
aumento das 

vendas

Demanda inelástica
em relação ao preço

Redução 
de preços è

Grande  
aumento das 

vendas

Demanda elástica
em relação ao preço

Modelo Econômico

• RT: receita total ($ mil)
• p: preço médio de todos os produtos
• a: nível de despesas com propaganda ($ mil)
• Comportamento esperado (ou médio) de 

muitos pontos de venda distintos
• Componente sistemático

apRTE 210)( βββ ++=

Modelo Econométrico

• Incorpora o termo de erro aleatório
• e: todos os fatores que fazem a receita total 

da semana diferir de seu valor esperado
(condições meteorológicas, comportamento 
dos concorrentes, etc.)

iiii apRT εβββ +++= 210

ii RTERT ε+= )(

componente
sistemático

componente
aleatório
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Análise Exploratória

Graph > Matrix Plot > Matrix of plots: Simple è

 
Correlations: receita total; preço; propaganda  
 
              receita tota         preço 
preço               -0,014 
                     0,921 
 
propaganda           0,925         0,101 
                     0,000         0,474 

 

receita total

140

120

100

2,52,01,5

preço

2,5

2,0

1,5

140120100

20

10

0

propaganda

20100

Matrix Plot of receita total; preço; propaganda

Estimativa de Mínimos Quadrados 
Ordinários para 2 Variáveis

• Minimização da soma dos quadrados das 
diferenças entre os valores observados e seu 
valor esperado

• Os estimadores de mínimos quadrados são 
obtidos através das derivadas de S em 
relação a ß0, ß1 e ß2.

√ Os cálculos não são triviais

( ) ( )∑∑
==

−−−=−=
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i
iii
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i
ii xxyYEyS
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2
22110

1

2
210 )(),,( ββββββ
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Cálculo das EMQO
• Na prática, usam-se pacotes computacionais 

para calcular as estimativas de mínimos 
quadrados (EMQO)

• No Minitab, o caminho é o mesmo:
Stat > Regression > Regression è

 
Regression Analysis: receita total versus preço; propaganda  
 
The regression equation is 
receita total = 105 - 6,64 preço + 2,98 propaganda 
 
 
Predictor      Coef  SE Coef      T      P 
Constant    104,786    6,483  16,16  0,000 
preço        -6,642    3,191  -2,08  0,043 
propaganda   2,9843   0,1669  17,88  0,000 
 
 
S = 6,06961   R-Sq = 86,7%   R-Sq(adj) = 86,2% 
 
 
Analysis of Variance 
 
Source          DF       SS      MS       F      P 
Regression       2  11776,2  5888,1  159,83  0,000 
Residual Error  49   1805,2    36,8 
Total           51  13581,4 

 

Lanchonetes – Regressão Ajustada

O vetor de coeficientes é: )98,2;64,6;78,104(ˆ −=β

Notação Matricial – Regressão Múltipla

Y  =       X  β + ε

123,1
124,3

...
124,6
127,2

= +

1    1,92   12,4
1    2,15    9,9
...     ...      ....   
1    2,29     9,2
1    2,36    10,2

e1
e2
e3
e4
e5

β0
β1
β2

Matriz de dados
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Estimador de Mínimos Quadrados

Estimador de mínimos quadrados de β, isto é, 
o vetor que     minimiza a função 
L(β) = ε’ε = (Y - Xβ)’(Y - Xβ) :

Y)X(X)X(    ˆ -1 ′′=β

β̂

)ˆ,,ˆ,ˆ(    ˆ
21 kββββ L=

εβ += XY

• Carregue os dados no Minitab:
√ Insira uma coluna antes da variável preço

Editor > Insert Columns
√ Preencha-a com 1’s:

Calc > Make Patterned Data > Simple Set of Numbersè

First value: 1
Last value: 1
In steps of: 1
List each value: 52 times

• Crie a matriz de dados (X)
 

MTB > Copy C2-C4 M10 
MTB > name M10 'Dados' 

 

• O vetor dos coeficientes é dado por:

• O cálculo matricial é facilmente alcançado:

Y)X(X)X(    ˆ -1 ′′=β

 
MTB > Transpose dados 'transposta' 
MTB > Multiply transposta dados M3 
MTB > Inverse M3 M4 
MTB > Multiply M4 transposta M5 
MTB > Multiply M5 'receita total' C5 
MTB > Print C5 
  
Data Display  
 
C5 
   104,786    -6,642     2,984 
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Matriz de Variâncias e Covariâncias

• Para o caso de duas variáveis explicativas:



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
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

=Σ
)ˆ()ˆ,ˆ()ˆ,ˆ(

)ˆ,ˆ()ˆ()ˆ,ˆ(
)ˆ,ˆ()ˆ,ˆ()ˆ(

22120

21110

20100

βββββ
βββββ
βββββ

VarCovCov
CovVarCov
CovCovVar

Cálculo no Minitab

• O Minitab, não apresenta a matriz de 
variância e covariância em sua saída

• Para seu cálculo:
Stat > Regression > Regression è

• Serão armazenados uma matriz de 
resultados (X’X)-1 e uma constante (MSE)

• No Minitab, matriz é identificada com a 
letra M e constante com a letra K.

• Os resultados armazenados podem ser 
verificados em:

Data > Display Data è
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Variâncias e Covariâncias – Lanchonetes

• Para se obter a matriz de variâncias e 
covariâncias, basta se multiplicar o MSE
(constante) por (X’X)-1 (matriz)

 
MTB > Multiply K2 M1 M2 
MTB > Print M2 
  
Data Display  
 
 Matrix M2 
 
 42,0256  -19,8631  -0,161109 
-19,8631   10,1837  -0,054021 
 -0,1611   -0,0540   0,027868 
 

Variâncias dos EMQO – Lanchonetes

0,02787

10,184

42,026)ˆ( 0βVar

)ˆ( 1βVar

)ˆ( 2βVar

Exercício 2 – Ajuste de Regressão

• Para o banco de dados abaixo, determine:
√ Faça um matrix plot, relcionando todas as 

variáveis
√ Faça um regressão linear múltipla dos dados e 

determine a estimativa de mínimos quadrados 
através da relação matricial: ß = (X’X)-1X’Y

√ Construir a matriz de variâncias e covariâncias 
do vetor de coeficientes

√ Dados: delivery_time_data.txt
ftp://ftp.est.ufmg.br/pub/lupercio/
delivery_time_data.txt
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• Delivery Time Summary:
A soft drink ottler is analysing the vending machine service 
routes in his distribution system. He is interested in 
predicting the amount of  time required by the route driver 
to service the vending machines in an outlet. This service 
actvity includes stocking the machine with beverage 
products and minor maintenance or housekeeping.  The 
industrial engineer responsile for the study has suggested 
that the two most important variables affecting the delivery 
time are the numer of cases of product stocked and the 
distance walked by the route driver.

Obs : observation
Del_Tim: delivery time (minutes)
NCases : numer of cases of product stocked
Dist : distance walked by the route driver (feet)

Solução

• Inserido coluna de 1’s em C2
Y: Del_Tim em C1
Explicativas: NCases, em C3 e Dist, em C4.

• Cálculos para obter o vetor de coeficientes
 
MTB > Copy c2-c4 M1 
MTB > Name M1 'Xis' 
MTB > Transpose Xis M2 
MTB > Name M2 'transposta' 
MTB > Multiply transposta xis M3 
MTB > Inverse M3 M4 
MTB > Multiply M4 transposta M5 
MTB > Multiply M5 C1 C5 
 
MTB > print c5 
  
Data Display  
 
C5 
   2,34123   1,61591   0,01438 

 

• Para obter a matriz de variâncias e 
covariâncias é necessário ajustar a regressão
√ MSE está armazenado em MSE1 e (X’X)-1 em 

XPXI1
Verificar em Data > Display Data

 
MTB > multiply MSE1 XPXI1 M10 
MTB > print m10 
  
Data Display  
 
 Matrix M10 
 
 1,20282  -0,0472626  -0,0008890 
-0,04726   0,0291504  -0,0005084 
-0,00089  -0,0005084   0,0000131 

 

Matriz de Variâncias
e Covariâncias
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Cadeia de Markov

• Suponha um sistema mudanças a cada 
instante (passo), ocupando um dentre finitos 
estados;
(condições do tempo por dia)

• Se a probabilidade de um estado ocorrer 
depender apenas do conhecimento do passo 
anterior, então o processo de mudança de um 
estado para outro é chamado Cadeia (ou 
Processo) de Markov.

Exemplo – Locadoras de Carros

• Sejam as lojas A, B e C de uma rede de 
locadoras de automóveis.

• O cliente pode devolver o carro alugado em 
qualquer uma destas lojas. A devolução ocorre 
de acordo com as seguintes probabilidades:


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R
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A B       C
Devolve

Vetor de Estados

• Fornece a probabilidade de o carro estar em 
cada uma das lojas logo após sua devolução 
após n locações:

• Se o carro é locado inicialmente na loja B, 
então o vetor de estados inicial é:
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Cálculo das Probabilidades em cada 
Locação

• As probabilidades na 1ª devolução são:

• Ou seja, na n-ésima devolução o vetor de 
estado será calculado por:

[ ] [ ]5,02,03,0
2,06,02,0
5,02,03,0
1,01,08,0

010'1 =










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
=X
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










= −

2,06,02,0
5,02,03,0
1,01,08,0

'' 1nn XX

• Carregando a matriz de transição no Minitab:

• Para facilitar os cálculos podemos obter os 
resultados em colunas. Para isto usaremos a 
relação:

• A operação será simplificado, pois os 
resultados poderão ser dispostos em colunas
Nomeie as coluna X1, X2, ..., Xn

 
MTB > Read 3 3 M1 
DATA> 0,8 0,1 0,1 
DATA> 0,3 0,2 0,5 
DATA> 0,2 0,6 0,2 
3 rows read. 

 

1−= n
T

n XPX

• Pode-se multiplicar sucessivamente, 
verificando os resultados nas colunas:

 
MTB > Transpose M1 M2 
MTB > Name M2 'transicao' 
MTB > multiply transicao X0 X1 

 

 
MTB > multiply transicao X1 X2 
MTB > Multiply transicao X2 X3 
MTB > Multiply transicao X3 X4 
MTB > Multiply transicao X4 X5 
MTB > Multiply transicao X5 X6 
MTB > Multiply transicao X6 X7 
MTB > Multiply transicao X7 X8 
MTB > Multiply transicao X8 X9 
MTB > Multiply transicao X9 X10 
MTB > Multiply transicao X10 X11 
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Distribuição Estacionária

• Os valores das probabilidades estão muito 
próximos à medida em que as devoluções 
ocorrem.

 
MTB > Print c1 - c12 
  
Data Display  
 
Row  X0   X1    X2     X3      X4       X5        X6        X7        X8 
  1   0  0,3  0,40  0,477  0,5114  0,53291  0,543748  0,550003  0,553313 
  2   1  0,2  0,37  0,252  0,2607  0,24002  0,237537  0,233111  0,231754 
  3   0  0,5  0,23  0,271  0,2279  0,22707  0,218715  0,216886  0,214933 
 
Row        X9       X10       X11 
  1  0,555163  0,556162  0,556713 
  2  0,230642  0,230162  0,229854 
  3  0,214195  0,213676  0,213432 

 

• Refaça os cálculos considerando o carro 
iniciando na loja A ou B. O que acontece?

• Cálculo da cadeia com início em A:
√ Coloque em X0 o vetor: (1, 0, 0)
√ Em Windows > Project Manager > History

Selecione os comandos dos cálculos efetuados
Clique Command Line Editor, com o botão direito 
do mouse:

• Verifique e/ou corrija os comandos e clique 
em Submit Commands

• Verifique os resultados



20

• Ou seja, caso o carro saia da loja A, após o 
11ª devolução, as probabilidades de estar 
em cada uma das lojas é muito próxima 
daquelas calculadas caso tivesse saído de B

 
MTB > print x0 - x11 
  
Data Display  
 
Row  X0   X1    X2     X3      X4       X5        X6        X7        X8 
  1   1  0,8  0,69  0,630  0,5971  0,57912  0,569273  0,563887  0,560939 
  2   0  0,1  0,16  0,191  0,2086  0,21801  0,223236  0,226069  0,227629 
  3   0  0,1  0,15  0,179  0,1943  0,20287  0,207491  0,210044  0,211432 
 
Row        X9       X10       X11 
  1  0,559326  0,558444  0,557961 
  2  0,228479  0,228945  0,229200 
  3  0,212195  0,212611  0,212839 

 

• Repetindo o procedimento para início em C:

• Independente de onde o cadeia inicie, são 
aproximadamente iguais as probabilidades 
relativas à sua 11ª devolução.

• Além disso, os valores de cada 
probabilidade mostram-se convergentes.

 
MTB > print x0 - x11 
  
Data Display  
 
Row  X0   X1    X2     X3      X4       X5        X6        X7        X8 
  1   0  0,2  0,38  0,454  0,5030  0,52686  0,540942  0,548292  0,552437 
  2   0  0,6  0,26  0,306  0,2506  0,24826  0,237266  0,234623  0,232005 
  3   1  0,2  0,36  0,240  0,2464  0,22488  0,221792  0,217086  0,215558 
 
Row        X9       X10       X11 
  1  0,554663  0,555896  0,556565 
  2  0,230979  0,230277  0,229941 
  3  0,214358  0,213828  0,213493 

 

Potência de uma Matriz

• Calcule P2, P4, P8, P16, P32:
 
MTB > Multiply M1 M1 M2 
MTB > Multiply M2 M2 M3 
MTB > Multiply M2 M2 M4 
MTB > Multiply M4 M4 M8 
MTB > Multiply M8 M8 M16 
MTB > Multiply M16 M16 M32 
MTB > print M2 M4 M8 M16 M32 
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• A matriz converge para a distribuição estacionária, 
ou seja, independente de qual local ocorreu a 1ª
locação, após muitas devoluções, será a mesma a 
probabilidade de o carro estar na loja A, B ou C.

 Matrix M2 
 
0,69  0,16  0,15 
0,40  0,37  0,23 
0,38  0,26  0,36 
 
 
 Matrix M4 
 
0,5971  0,2086  0,1943 
0,5114  0,2607  0,2279 
0,5030  0,2506  0,2464 
 
 
 Matrix M8 
 
0,560939  0,227629  0,211432 
0,553313  0,231754  0,214933 
0,552437  0,232005  0,215558 
 
 

 
 
 Matrix M16 
 
0,557406  0,229493  0,213101 
0,557344  0,229525  0,213130 
0,557337  0,229529  0,213134 
 
 
 Matrix M32 
 
0,557377  0,229508  0,213115 
0,557377  0,229508  0,213115 
0,557377  0,229508  0,213115 

 

Exercício 3 – Matriz Estocástica

• Seja a matriz estocástica dada por:

• Calcule Pk, para k = 2, 4, 26, 32, 64, 128
• O que acontece com as colunas de Pk

quando k cresce?



















=

1765,02395,05451,00389,0
2067,01589,03277,03067,0
2093,01502,02723,03682,0
2047,01935,02663,03355,0

P

• Através de:
√ Window > Project Manager > History
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MTB > print M2 M4 M8 M16 M32 M64 M100 
  
Data Display  
 
 Matrix transicao 
 
0,277921  0,336849  0,184690  0,200539 
0,278000  0,335509  0,186140  0,200351 
0,280332  0,335651  0,183321  0,200696 
0,294077  0,333484  0,169729  0,202709 
 
 
 Matrix M4 
 
0,281633  0,335501  0,181926  0,200940 
0,281633  0,335502  0,181924  0,200940 
0,281632  0,335504  0,181923  0,200940 
0,281632  0,335517  0,181909  0,200943 
 
 
 Matrix M8 
 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
 
 
 Matrix M16 
 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
 

 
 Matrix M32 
 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
 
 
 Matrix M64 
 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
 
 
 Matrix M100 
 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 
0,281633  0,335505  0,181921  0,200941 

 

• P4 já mostrou valores bastante próximos da 
convergência

Diagonalização de Matrizes

Diagonalização de Matrizes Simétricas

• Em muitas aplicações é necessário obter 
autovalores e autovetores de matrizes, ou 
seja, a matriz P e ? tal que:

onde:
P: matriz dos autovetores e
? : matriz diagonal dos autovalores

'PPA Λ=
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• Seja a matriz simétrica:

• Carregando no Minitab

















−
−

−−
=

511
162
126

A

 
MTB > Read 3 3 M1 
DATA> 6 -2 -1 
DATA> -2 6 1 
DATA> -1 1 5 
3 rows read. 
MTB > print M1 
  
Data Display  
 
 Matrix Xis 
 
 6  -2  -1 
-2   6   1 
-1   1   5 

 

Autovalores e Autovetores

• Ou, digitando pelo teclado:
√ Editor > Enable Commands
√ Eigen M1 C1 M2.

Calc > Matrices > Eigen Analysisè

• Autovalores e Autovetores de A:

• A matriz de Autovalores (? ) será:

 
MTB > print M2 
  
Data Display  
 
 Matrix M2 
 
 0,657192  -0,260956  0,707107 
-0,657192   0,260956  0,707107 
-0,369048  -0,929410  0,000000 
 
MTB > print C1 
  
Data Display  
 
C1 
   8,56155   4,43845   4,00000 

 

P: matriz de Autovetores

Autovalores

 
MTB > Diagonal C1 M3 
MTB > Name M3 Lambda 
MTB > Print Lambda 
  
Data Display  
 
 Matrix Lambda 
 
8,56155  0,00000  0 
0,00000  4,43845  0 
0,00000  0,00000  4 
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Decomposição de A

• A pode ser decomposta como:

ou seja:

'PPA Λ=

 
MTB > Name M2 'Pe' 
MTB > Multiply Pe Lambda M4 
MTB > Transpose Pe M5 
MTB > Multiply M4 M5 M6 
MTB > Print M6 
  
Data Display  
 
 Matrix M6 
 
 6  -2  -1 
-2   6   1 
-1   1   5 

 

A: matriz original

Inversão de Matriz Simétrica

• Facilmente obtida através de autovalores e  
autovetores:

• Para inverter uma matriz diagonal basta 
inverter os elementos de sua diagonal. Assim:

'11 PPA −− Λ=

 
MTB > Let C2 = 1/C1 
MTB > Diagonal C2 M7 
MTB > Name M7 'Lambda_inv' 
MTB > Multiply Pe 'Lambda_inv' M8 
MTB > Multiply M8 M5 M9 
MTB > Print M9 
  
Data Display  
 
 Matrix M9 
 
0,190789   0,059211   0,026316 
0,059211   0,190789  -0,026316 
0,026316  -0,026316   0,210526 

 

A-1: inversa de A

 
MTB > Let C3 = C1**2 
MTB > Diagonal C3 M11 
MTB > Name M11 'Lambda_quad' 
MTB > Multiply Pe 'Lambda_quad' M12 
MTB > Multiply M12 M5 M13 
MTB > Print M13 
  
Data Display  
 
 Matrix M13 
 
 41  -25  -13 
-25   41   13 
-13   13   27 

 

Potência de Matriz Simétrica

• Através de autovalores e  autovetores, tem-se:

• Para obter a potência de uma matriz diagonal 
basta elevar os elementos de sua diagonal. 
Assim, para obter A2:

'PPA kk Λ=

A2
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• Conferindo, temos:
 
MTB > inverse m1 m10 
MTB > print m10 
  
Data Display  
 
 Matrix M10 
 
0,190789   0,059211   0,026316 
0,059211   0,190789  -0,026316 
0,026316  -0,026316   0,210526 

 

A-1

 
MTB > Multiply m1 m1 m14 
MTB > Print m14 
  
Data Display  
 
 Matrix M14 
 
 41  -25  -13 
-25   41   13 
-13   13   27 

 

A2
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